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Updating Database 

The Record in an Existing Database 

Search a Record in an Existing Database 

In this sub topic explains how to update existing data. Microsoft Office Access 2007 provides a 

number of tools for updating existing records, including datasheets, forms, queries, find-and-

replace, and the new Data Collection feature. As you proceed, remember that updating data is not 

the same process as entering new data. 

Use an update query to change existing data 

• You use update queries to add, change, or delete part (but not all) of one or more existing 

records. You can think of update queries as a powerful form of the Find and Replace 

dialog box. You enter a select criterion (the rough equivalent of a search string) and an 

update criterion (the rough equivalent of a replacement string). Unlike the dialog box, 

update queries can accept multiple criteria, allow you to update a large number of records 

in one pass, and allow you to change records in more than one table.--Remember that you 

cannot use update queries to add entire records. To do that, you use an append query. 

Note: The safest way to use an update query is to first create a select query that tests your 

selection criteria. For example, suppose that you want to update a series of Yes/No fields from 

No to Yes for a given customer. To do so, you add criteria to your select query until it returns all 

of the desired No records for that customer. When you are sure that you have the correct records, 

you then convert your select query to an update query, enter your update criteria, and then run 

the query to update the selected values. The steps in this section explain how to create a select 

query and then convert it to an update query. 

Use Data Collection to update records 

Office Access 2007 provides a new feature called Data Collection. You can set up a data entry 

form in Microsoft Office Outlook 2007, gather information, and store that data in an Access 

database. 

• Use the Find and Replace dialog box to change data 

• The Find and Replace dialog box provides another way to change small amounts of data 

in less time and with less effort. 

Search for a record in Access database 

• When you enter text in the Search box, the first matching value is highlighted in real time 

as you enter each character. You can use this feature to quickly search for a record with a 

matching value.You can also search for a specific record in a table or form by using the 

Find option. 

 



2 
 

This is an effective choice for locating a specific record when the record that you want to locate 

satisfies specific criteria, such as search terms, and comparison operators, such as "equals" or 

"contains". 

Note: You can only use the Find and Replace dialog box if the table or form currently displays 

data. This is true even if there are no visible records because a filter has been applied. 

• Open the table or form, and then click the field that you want to search. 

• On the Home tab, in the Find group, click Find. 

• The Find and Replace dialog box appears, with the Find tab selected. 

 

• In the Find What box, type the value for which you want to search. 

• To change the field that you want to search or to search the entire underlying table, click 

the appropriate option in the Look In list. 

• Tip: The Match list represents your comparison operator (such as "equals" or "contains"). 

To broaden your search, in the Match list, click Any Part of Field. 

• In the Search list, select all, and then click Find Next. 

• When the item for which you are searching is highlighted, click Cancel in the Find and 

Replace dialog box to close the dialog box. Records that match your conditions are 

highlighted 

Queering Database 

Query Database Using Logical Operators 

Queries are the fastest way to search information in a database. A query is a database feature that 

enables the user to display records as well as perform calculations on fields from one or multiple 

tables. You can analyze a table or tables by using: 

• Select query 

• An action query 

Action query: These are queries that are used to make changes in many records at once. There 

are mostly used to delete, update, add a group of records from one table to another, or create a 

new table from another table Types of action query in Microsoft Access are: 

1. Update-update data in a table 

2. Append Query-add data in a table from one or more tables. 

3. Make table Query-Creates a new table from a dynaset 

4. Delete query-Delete specified records from one or more tables 
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Select Query Is a type of query used for searching and analyzing data in one or more tables. It 

lets the user specify the search criteria and the records that meet those criteria displayed in a 

dynaset or analyzed depending on the user requirement. 

Creating a selected query 

1. Ensure that the database you want to create a query for is open 

2. Click the query tab, then new 

3. In the new query dialog box, choose either to create a query from in designing view or 

using Wizard 

4. To design from scratch, click design view. The show table dialog box appears from 

which you can add a table or tables you wish to create in a query form. 

5. Click the table from the query list and then click add 

6. Click close to close the show table dialog box. 

7. The query design grid opens. In Microsoft Access it is called query example (Q.BE) 

Specifying the search criteria 

• To search for a particular set of records, you have to enter a conditional statement or 

statements in the criteria.  

Example: If you have a table called employees with one of fields as salary, you can display 

all the employees earning more than shs.5000 by typing > 5000 in the criteria row, salary 

column. 

• To define criteria, use either relational or logical operations, Relational operators include 

• Less than < 

• Greater than > 

• Greater than or equal to >= 

• Less than or equal to <= 

• Not equal to <> 

• Equal to = 

• Logical operators include AND, OR and NOT 

• AND is used to display values in a specific range.Example: if you type >4000 AND 

<6000 on criteria row in salary column. All employees who meet this condition will be 

displayed 

• OR is used to display either one of the two values eg: if you wish to get those employees 

either in Dar es Salaam or Morogoro 

• TO Display data in a particular range, use the word between eg in steady of typing >4000 

AND >6000, type between 4000 AND 6000 

• NOT is used to display all records except that you do not want to see.Eg if you type NOT 

8000 in salary column of the employees table. All employees’ records will be displayed 

except those with the salary 8000. 
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Modifying and updating a query 

To delete fields from the query grid. 

1. Open the desired query in design view 

2. Position the mouse pointer at the boundary that separates columns, then drag it to the 

required size. Alternatively, double click the boundary to auto fit cell content. 

3. Click the save button to save the changes 

4. To test whether the changes have been affected, click the run button to display the results 

of the query 

 

 

Generating Reports 

Report Layout by Using Design View Mode 

Create Report Layout by Using Design View Mode 

Report layout is designed by placing control on the report designer parts of a report. Report 

Header – This contain unbound controls that display title of the report Page Header- this contains 

heading or tables data items to be displayed in every column. Detail-Holds bound controls that 

display data items for the table or query it was created from Page footer-Holds the control that is 

to be displayed on every page such as the page number and data Report footer-Used to display 

summary from a report such as the grand total for numerical data in a particular field column. 

Creating a Report in a Design View 

1. In a database windows, click the reports card then new 

2. In the new report dialog box, click design view 

3. Click the name of the table or query you want to generate a report from 

4. Click the OK button. You will get a report grid where you can place data controls. 

5. From the view menu, click Field list. 

6. To design the layout, drag each field from the field list to the layout grid and drop it 

where you want the data column to appear. 

7. Once you finish placing controls, click save button 

8. In the save as dialog box, enter the name of the report and click ok 

9. To view the report click the print preview button alternatively click print preview from 

the file menu 

To modify header and footers 

• Open the report in design view 

• Click the report header or footer you want to modify 

• Make the necessary changes and then click modify 

• Click the print preview button to view changes 

To add more controls on to the report layout 
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• Open a report in design view. 

• Display the field list by clicking the field list button or using the view. 

• Select one or more fields in the field list and drag view to the report design view grid. 

To resize or move a control 

• Click the control to select it. Position the mouse pointer on the place holder, until the 

mouse pointer changes to a double sided arrow. 

• Drag the pointer to resize the control 

• To move a control, select it and placed the mouse pointer on the place holder until it 

changes to a hand then drag. 
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The Concept of Presentation 

Explain the Concept of Presentation 

This is the structured, prepared and speech-based means of communication or idea to a group of 

interesting people in order to inform or persuade them 

Microsoft Presentation software (power point) including text-editing and graphic tools that can 

create slides for public presentation. The presentation can be printed, projected, displayed on a 

monitor saved and published on web pages. 

ART AND SKILLS OF PRESENTATION 

An important part of preparing presentation is to decide on which method of delivery is most 

compatible with the topic of presentation and the type of audience. For a person interested in 

presentation delivery methods, four methods exist for delivering an oral presentation. The 

following are methods for deliver presentation 

Manuscript 

• The manuscript method is a form of speech delivery that involves speaking from text. 

With this method, a speaker will write out her speech word for word and practice how 

she will deliver the speech. A disadvantage of this method is a person may sound too 

practiced or stiff. To avoid sounding rehearsed, use eye contact, facial expressions and 

vocal variety to engage the audience. Use frequent glances at highlighted key points 

instead of reading the speech word for word. 

Memorization 

• The memorization method is a form of speech delivery that involves fully memorizing a 

speech before delivering it. This method of delivery allows a speaker to move around the 

stage or platform and maintain eye contact with the audience without relying on a script 

or notes. For speakers who deliver their speeches by memorization, add inflection to the 

voice and keep notes nearby to avoid forgetting an important key point. 

Impromptu 

• The impromptu method is a form of speech delivery that involves speaking from notes. 

This method is ideal for a speaker needing to deliver a short speech with little preparation 

time. With the impromptu method, a speaker will organize his speech in outline form, 

create notes with the key points of the presentation and deliver the speech from the notes. 

This method allows a speaker to deliver a speech in a natural manner while maintaining 

eye contact and engaging an audience. 

Extemporaneous 

• The extemporaneous method is a form of speech delivery that involves combining the 

manuscript, memorization and impromptu methods to create a carefully prepared and 

planned speech. For this method, a speaker will organize a speech with an outline, write 

down the speech word for word and practice the delivery. A speaker may highlight key 

points in the speech to quote verbatim and memorize other portions of the speech to 
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speak in a more conversational tone. The extemporaneous method of delivery allows a 

speaker to engage an audience and adapt to any speaking situation. 

The Presentation Delivery Mode 

Mention Presentation Delivery Mode 

Presentation can be delivery through 

• Radio 

• Television 

• Face to face 

• Projectors such as OHP (overhead projector) and LCD projector 

Why Presentation Skills are required? 

• To properly structure your presentation. 

• To overcome nervousness. 

• To develop powerful Body Language. 

• To deliver effective presentation. 

• To learn what not to do during presentation 

• To design and use visual aids effectively 

Common cause of Ineffective Presentation 

• Failure to motivate the audience 

• Confusing structure 

• Excessive details 

• Poorly designed slides 

The General arts and Skills of Presentation 

Outline General arts and Skills of Presentation 

Presentation require the following skills 

1. Begin with the end in mind, Before starting, think of the final outcome you want to 

achieve with your presentation. Have a clear overall picture and focus on it throughout 

the whole presentation. 

2. The rule of KISS, A presentation should always be concise and easy to understand. This 

rule refers to the importance of Keeping It Short and Simple. For a successful 

presentation, you need to stay on topic and always be clear about what you want to 

transmit. 

3. Less is more, Reiterating point no. 2: make your presentation as easy to understand as 

possible, don’t complicate it - keep it simple. Explain your presentation in a way that 

everyone will understand, don’t overdo it with too much text but focus on key words 

instead. The less you have on your presentation slides, the better in order to keep your 

audience interested. 



8 
 

4. Connect with your audience, Before a presentation always find out who your audience 

is and try to adapt your presentation to them. Know what your audience is interested in so 

you can adapt and capture their attention. 

5. Right to speak, Everyone gets nervous before a presentation - after all, public speaking 

is considered people’s number one fear. So try to relax, breathe and be calm. Don’t focus 

on how stressed you are, but rather try to focus on your breathing. 

6. Be yourself, The most important piece of all – be genuine. Share your passion and 

excitement with the audience. 

 

Non - electronic Presentation 

Demonstrate Non- electronic Presentation 

Non- electronic communication involves the distribution of a message usually in the form 

of: Reports, Letters, Flow Charts, Invoices and even Verbal Communication amongst 

employees. This form of communicating is not as popular as it once was, but it provides 

businesses with other avenues to communicate instead of electronic communication. 

Furthermore, different types of communication suit contrasting businesses in addition to, the 

preference of people involved within a business. 
 

 

The Art and Skills of Electronic Presentation 

Outline the Art and Skills of Electronic Presentation 

Normally means a presentation using multimedia of voice, image and electronic file (such as 

Microsoft word, Excel or power point), with computer transmission via the internet or phones, as 

opposed to being present in person and handling out a paper copy to the audience 

Advantages of using electronic presentation 

• It can give a visual explanation of what you are trying to say. 

• It can be used to reinforce important information 

• It can be used to link complex ideas - themes, build up diagrams etc 

• It can be used to summarize information 

• It can be used to give further definition of information cool 

Disadvantages of using electronic presentation 

Limit the words, otherwise clutter with be off putting Make sure you understand the slides before 

presenting otherwise you may rush Make sure the background and text are clear to the audience 

Obviously with technology thing can go wrong such as computers/usb losing data 

Open a Presentation Program 

Open a Presentation Program 

How to start MS – power point program 

• Open Start menu 

• Go to program 

• Choose Microsoft office 
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• Choose Microsoft power point program 

• MS window will appear 

Exploring MS – power point window 

• Title bar 

• Menu bar 

• Standard bar 

• Formatting toolbar 

• Vertical and Horizontal Ruler bar Bars 

• Working place 

• Horizontal and Vertical Scroll bars 

• Status Tools bar 

• Task bar 

Understanding Power point views 

• Slide views 

• Outline views 

• Slide sorter 

• Notes pages 

Printing the Presentation Document 

Perform Page Set Up 

Perform Page Set Up 

Preview a Presentation 

Preview a Presentation 

Print the Slides / Handout 

Print the Slides / Handout 

The steps if you are using Power Point 2007 

• On your PC 

• Click File > Print. 

• Specify how many copies you want to print. 

 

• Ensure that the selected printer is the one you want to use. 
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• Click the down arrow, as illustrated, to see more printer options, including the Add 

Printer command that helps you connect to a different printer available on your network: 

 

• If you're through setting print options, select print. Otherwise, continue to mark other 

settings (such as which slides to print and the layout for notes or handouts) as described 

in the following procedures. 

• If you decide not to print after you've opened the Print dialog box, just switch to another 

tab on the PowerPoint generic ribbon, such as Home, to dismiss the Print dialog box. 

• Specify which pages you what to print 

 

• By default, the first option under Settings in the Print dialog box is set to Print All Slides. 

• If you don't want to print all slides, in the Slides box, you can type the numbers of the 

slides to be printed. Type individual slide numbers and/or hyphenated ranges of slides, 

and separate them with commas (spaces are not necessary): 

 

• For example, typing: 1, 3, 5-7, 10 would print slides 1, 3, 5, 6, 7, and 10. 
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You can also click the down arrow and change Print All Slides to another option such as Print 

Current Slide or Print Selection: 

 

• To print one or more slides that you select, go back to the Home tab, and in Normal view, 

select your slides from the thumbnail pane on the left. To select multiple slides, press and 

hold Ctrl while you click the slides you want to print. When you're done with your 

selection, click File > Print, and use the Print Selection option. 

• To print the slide that you were working on right before choosing File > Print, use the 

Print Selection option. (After you choose this option, the preview pane shows you which 

slide will be printed.) 

To print Notes and Slides 

• When you print speaker notes, you get one slide per page, with space allotted for speaker 

notes below the slide. The Preview pane in the Print dialog box shows you what your 

printed page will look like. 

• In the Print dialog box, under Settings, select the second box (which by default is set to 

Full Page Slides) to expand the list of options. Then, under Print Layout, select Notes 

Pages. 
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• If you're through setting print options, select print. Otherwise, continue to mark other 

settings as described in the other procedures in this article. 

To print handout 

• You can print handouts that show 1, 2, 3, 4, 6, or 9 slides per page. If you print three 

slides per page, the slides appear on the left side of the page with printed lines for note-

taking on the right side of the page. This "three-up" layout is the only one that includes 

printed lines for note-taking. 

• In the Print dialog box, under Settings, select the second box (which by default is set to 

Full Page Slides) to expand the list of options. Then, under Handouts, select the page 

layout you want. 
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• For handout pages containing four, six, or nine slides, there are two options to choose 

from for each: horizontal ordering (as illustrated in the first picture below) or vertical 

ordering (the second picture below). 
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• If you're through setting print options, select print. Otherwise, continue to mark other 

settings as described in the other procedures in this article 

Print full page slides 

• With this option you get one slide per page. The orientation (Landscape or Portrait) of the 

printed pages is automatically matched to the orientation of your slide layout. 

• In the Print dialog box, under Settings, ensure that the second box is set to Full Page 

Slides. If it isn't, click the down arrow on the control to expand the list of options. Then, 

under Print Layout, select Full Page Slides. 
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• If you're through setting print options, select print. Otherwise, continue to mark other 

settings as described in the other procedures in this article. 

• Other layout options: Select Frame Slides to print a thin border around each slide. Select 

Scale to Fit Paper to ensure that the slide content is printed in the maximum size that will 

fit on the page size and orientation you've selected. Select the High quality option to 

increase resolution, blend transparent graphics, and print soft shadows in your printout. If 

you choose Print Comments and Ink Markup, a separate page is printed for the comments 

that are in the presentation. 
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The Concept of Desktop Publishing 

Explain the Concept of Desktop Publishing 

Microsoft Publisher is a software application developed by Microsoft Corporation to help 

Businesses create high-quality marketing and business material. A part of the Office Product 

family, publisher provides business users with design options for a variety of publications, such 

as newsletters, flyers, brochures and Web pages. The term desktop means that all the publishing 

process cannot be done on a desk in the office or at home a personal computer. 

Desktop publishing (abbreviated DTP) is the creation of documents using page layout skills on 

a personal computer primarily for print.Or Desktop publishing is the use of the computer and 

software to create visual displays of ideas and information. Desktop publishing is a term coined 

after the development of a specific type of software. It's about using that software to combine 

and rearrange text and images and creating digital files for print, online viewing, or websites. 

Desktop publishing software can generate layouts and produce typographic quality text and 

images comparable to traditional typography and printing. This technology allows individuals, 

businesses, and other organizations to self-publish a wide range of printed matter. 

Examples of desktop publishing software: 

• Adobe page maker 

• Adobe in design 

• PagePlus 

• Microsoft Publisher 

• PageMaker 

• Express Publisher 

• Easy Working Desktop Publisher 

• QuarkXPre 

• Ventura Publisher 

• PFS: Publisher 

• FrameMaker 

Difference between word processing software and desktop publishing software 

• Word processing software is used for working with text, while desktop publishing 

software involves production of documents that combine text with graphics. 

• Desktop publishing software allows to work with more complicated page layouts than a 

word processing app. DTP software is perfect for making flyers, brochures, booklets. 

This type of software is usually more advanced than word processing apps. 

A good example of a word processing app is Microsoft Word while desktop publishing app - 

Microsoft Publisher. 

THE TYPES OF DESKTOP PUBLISHING SOFTWARE 

Desktop publishing software can be classified in to two broad categories which are: 

1. Graphic - based: These are specifically developed to edit and format graphic objects 

such as picture and victor drawings. 

2. Layout-based: These are specifically developed to create different page layout designs 

for text and pictures. 
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Purpose of desktop publishing software 

Graphic Design. 

• This is the number one use for desktop publishing and can be held accountable for why 

the term has changed so much over the years. Professional graphic designers use DTP 

programs such as QuarkXPress, Adobe PageMaker, and Adobe Photoshop to create 

webpages, the front pages of newspapers, and a variety of other visual documentation. 

Thanks to DTP, graphic design has become more than just pencil and paper. The 

introduction of desktop publishing has taken graphic design to greater heights. Without 

desktop publishing, there is no graphic design, and 

Career Assistance. 

• Word processing also has also played its part in the DTP world. Microsoft Word and 

Open Office are used faithfully by numerous job seekers everyday as they work to put 

together the perfect resume, cover letter, or portfolio. Many create documents from 

scratch, while others take advantage of the oh-so-convenient templates. 

Education. 

• In the education field, teachers and students use a variety of DTP programs to complete 

assignments and projects. Whether it’s an Intro to Desktop Publishing course and the 

program of choice is QuarkXPress, or a Technical Writing Course that takes an in-depth 

look at Microsoft Word, the use of DTP in educational institutions is very prevalent. 

Business. 

• Today, desktop publishing is pretty much used to handle all of the “paperwork" of a 

business. Although it’s possible to run a business without the help of DTP, it isn’t the 

smartest business decision. From sole-proprietorships to Fortune 500 companies, DTP 

software is a lifesaver and money saver. Examples of DTP use in businesses are business 

cards, legal documentation, and advertising materials. 

The Various Features of the Desktop Publishing Program 

Examine Various Features of the Desktop Publishing Program 

Below is a list and description of the most basic and essential features that any desktop 

publishing software should have. Some of them may prove more crucial than others depending 

on the type of print project you are working with. Though these features are important, the list 

surely does not end here. 

• Support for Numerous Project Types: The ability to create a variety of projects defines 

the flexibility of a desktop publishing application. The key to delivering this is by 

supporting an abundance of paper layouts and the ability to create custom page layouts 

without too many restrictions.  

• Layout Tools: The term “layout tools” involves a range of tools that help to place and 

align objects accurately. Such tools include but are not limited to rulers, adjustable and 
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automatic guides, multiple editing layers, object snapping, and object grouping. The 

guides and snapping options offer a point of reference when placing images and text in 

the document. Multiple editing layers keep the workspace more or less uncluttered which 

helps to prevent selecting and moving the unintended object. Object grouping helps in a 

similar way by making sure that multiple objects remain positioned proportionate to one 

another.The integration of so-called “master pages” in a desktop publishing application 

saves you from having to create the same background multiple times for a multi-page 

document. This option creates a type of template that can be applied to every page of a 

document.  

• Text Tools: Desktop publishing software should offer a wide range of text editing tools 

extending beyond standard operations on text. Linked text boxes are an absolute must in 

desktop publishing. Such text boxes allow text to flow freely within a network of text 

boxes. This make editing text content much easier since the text boxes automatically 

adjust the contained text.Adjusting the text properties of headers and other portions of 

text can be quite tedious. Applications with styles sheets make that process much quicker. 

One can think of style sheets as customizable text templates that can be applied to any 

portion of text by selecting it and choosing the corresponding style sheet.Other important 

text tools include circle text and artistic text effects. 

• Graphic Tools: The ability to edit images is also an absolute must for desktop publishing 

software. Ideally, an application should allow you to do more than just manipulate 

images (resize, angle, crop, or compress). It should give you a set of built-in image 

effects and filters as well as other functions related to design. Such functions may include 

adding shadows, controlling the transparency, and so forth. Highly professional 

applications may offer advanced drawing tools.  

• Printing and Sharing: Supporting a ton of paper layouts and printers is not enough to 

make a desktop publishing application great. If you are running an older printer, you will 

definitely need the ability print your project as a raster image since many old printers 

cannot handle vector data. A person looking to send his document to the print shop will 

find that a variety of export options and the means to convert text to curves will turn out 

to be useful. Those who plan on printing any kind of booklet should look for an 

imposition functionality. 

 

reating and Producing a Publication 

Plan for a Publication 

Plan for a Publication 

Publication planning is the sub-industry to the pharmaceutical industry that does the 

organizational and practical work of shaping pharmaceutical companies' data and turning it into 

medical journal articles. 

Given below are some of the major decisions/actions that authors should take while creating a 

publication schedule. 

• Decide the format of your paper 

• Determine your journal strategy 

• Ensure that you meet all the submission requirements of the target journal 

• Take advantage of pre-submission inquiries 
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Design Layout of the Publication 

Design Layout of the Publication 

Create a publication by using one of the pre-designed publications 

• On the File menu, click New. 

• In the New Publication task pane, under New from a design, do one of the following: 

• To create a publication that you will print, click Publications for Print and then, under 

Publications for Print, click the type of publication that you want. 

• To create a Web site, or a publication that you will send as an e-mail message, click Web 

Sites and E-mail, click either Web Sites or E-mail, and then click the type of publication 

that you want. 

• In the Preview Gallery on the right, click the design that you want. 

Note: If you click Easy Web Site Builder under Web Sites, select the check boxes for the options 

that you want in the Easy Web Site Builder dialog box before continuing. 

Do any of the following: 

• To change the publication's overall design, click Publication Designs in the task pane, 

and then click the publication design that you want. 

• To change the publication's color scheme, click Color Schemes in the task pane, and then 

click the color scheme that you want. 

• To change the publication's font scheme, click Font Schemes in the task pane, and then 

click the font scheme that you want. 

• If you are creating a Web page, newsletter, or catalog, and you want to change the page 

content options, click Page Content, and then click the options that you want. 

• Change or select any additional options in the task pane. 

• In your publication, replace the placeholder text and pictures with your own text and 

pictures, or with other objects. 

• On the File menu, click Save As. 

• In the Save in box, select the folder where you want to save the new publication. 

• In the File name box, type a name for your publication. 

• In the Save as type box, select Publisher Files. 

• Click Save. 

Start with a blank publication 

• On the File menu, click New. 

• In the New Publication task pane, under New from a design, click Blank Publications. 

• In the Preview Gallery on the right, click the blank publication that you want. 

• In your publication, add text, pictures, and any other objects you want. 

• On the File menu, click Save As. 

• In the Save in box, select the folder where you want to save the new publication. 

• In the File name box, type a name for your publication. 

• In the Save as type box, select Publisher Files. 

• Click Save. 
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Create a publication from a design set 

Note: If you create a postcard or a business card by starting with one of these blank publications, 

your publication will be a Quick Publication, and you will not be able to use any of the task pane 

options that are available for the Postcard Wizard or the Business Card Wizard. 

If you want to create a range of different publications that all share a single consistent design, 

you can select a publication from a design set. 

• On the File menu, click New. 

• In the New Publication task pane, under New from a design, click Design Sets. 

• In the task pane, click the design set that you want. 

• In the Preview Gallery to the right, click the type of publication that you want. 

Do any of the following activities: 

• To change the publication's overall design, click Publication Designs in the task pane, 

and then click the publication design that you want. 

• To change the publication's color scheme, click Color Schemes in the task pane, and then 

click the color scheme that you want. 

• To change the publication's font scheme, click Font Schemes in the task pane, and then 

click the font scheme that you want. 

• If you are creating a Web page, newsletter, or catalog, and you want to change page 

content options, click Page Content, and then click the options that you want. 

• Change or select any additional options in the task pane. 

• In your publication, replace the placeholder text and pictures with your own text and 

pictures, or with other objects. 

• On the File menu, click Save As. 

• In the Save in box, select the folder where you want to save the new publication. 

• In the File name box, type a name for your publication. 

• In the Save as type box, select Publisher Files. 

• Click Save. 

Create a new publication based on an existing one 

You can create a new publication from an existing publication without modifying the original 

file. 

• On the File menu, click New. 

• In the New Publication task pane, under new, click from existing publication. 

• In the Create New from Existing Publication dialog box, locate and click the publication 

that you want to use as the basis for your new publication. 

• Click Create New. 

• Make the changes that you want in your new publication. 

• On the File menu, click Save As. 

• In the Save in box, select the folder where you want to save the new publication. 

• In the File name box, type a new name for your publication. 
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Add text or Graphics to the Layout of the Publication 

Add text or Graphics to the Layout of the Publication 

Insert WordArt 

WordArt is a quick way to make text stand out with special effects. You pick a WordArt style 

from the WordArt gallery, launched from the Insert tab, which you can then customize. 

 
1.Click Insert > WordArt, and pick the WordArt style you want 

 

• In the WordArt gallery, the letter A represents the different designs that are applied to all 

text you type. 
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• Note: The WordArt icon is located in the Text group, and it may appear different 

depending on the program you're using and the size of your screen. Look for one of these 

icons: 

 

• The placeholder text "Your text here" appears, with the text highlighted. 

 

• Enter your own text to replace the placeholder text. 

 

• Tips: You can enter entire sentences, and even paragraphs, as WordArt. (You may have 

to change the font size for longer text.) And in Word, you can also convert existing text 

to WordArt in Word.You can include symbols as WordArt text. Click the location for the 

symbol, and on the Insert tab, click Symbol, and pick the symbol you want. 

Customize WordArt 

You might have tried using shape styles to change the shape of WordArt and then were puzzled 

that the text didn’t change. Use the text options in the WordArt Styles group instead. Shape 

styles and effects apply to the box and background surrounding your WordArt, not to the 

WordArt text. So, to add effects to your WordArt, such as shadows, rotation, curves, and fill 

and outline colors, you use the options in the WordArt Styles group, including Text Fill, Text 

Outline, and Text Effects. 
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• Note: Depending on your screen size, you might only see the icons for WordArt Styles. 

 
Change the fill and outline color of WordArt text 

• Select the WordArt text or letters to change. 

• The Drawing Tools Format tab appears. 

• On the Drawing Tools Format tab, click Text Fill or Text Outline, and pick the color you 

want. 

 

• Click outside of your text box to see the effect. 

• In this example, a light blue text fill and a red text outline were applied. 
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Perform Formatting of Text and Graphics 

Perform Formatting of Text and Graphics 

The Procedure for Producing Publications 
 

 

 

Multimedia Concepts 

The Historical Development of Multimedia 

Explain Historical Development of Multimedia 

Today multimedia might be defined as the seamless digital integration of text, graphics, 

animation, audio, still images and motion video in a way that provides individual users with high 

levels of control and interaction. The evolution of Multimedia is a story of the emergence and 

convergence of these technologies. 

• Visionaries: From the ingenious idea of the programmable computer, trace the 

innovations of the outstanding thinkers that had a direct impact on the explosion of the 

technological age. 

• Text, Processing and Software: Inventions and innovations that spawned the 

development of software enabling computers to move from mathematical processing to 

technology that creates and delivers multi media. 

• Computers: From the printing press through the exclusive military and academic and 

corporate worlds trace computer development into the ubiquitous role of the desktop 

personal computer of today. 

• Audio & Communication: From the telegraph signal to cellular telephones, follow the 

development from signal transmission to digital transmission of voice 

• Video & Animation: From manually manipulated negative film and hand drawn 

sketches, video and animation develops to sophisticated digital creation and rendering of 

motion 

Therefore, Multimedia is content that uses a combination of different content forms such as text, 

audio, images, animations, video and interactive content. Multimedia contrasts with media that 

use only rudimentary computer displays such as text-only or traditional forms of printed or hand-

produced material. 

Multimedia can have a many definitions these include 
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• Multimedia means that computer information can be represented through audio, video, 

and animation in addition to traditional media Or 

• Multimedia is the field concerned with the computer-controlled integration of text, 

graphics, drawings, still and moving images (Video), animation, audio, and any other 

media where every type of information can be represented, stored, transmitted and 

processed digitally. 

Graphics 

These are visual images or designs on some surface, such as a wall, canvas, screen, paper, or 

stone to inform, illustrate, or entertain. In contemporary usage it includes: 

• A pictorial representation of data, as in computer-aided design and manufacture, 

• In typesetting and the graphic arts, and in educational and recreational software. 

Images that are generated by a computer are called computer graphics. Computer graphics are 

pictures and films created using computers. Usually, the term refers to computer-generated 

image data created with help from specialized graphical hardware and software. 

COLOR DEPTH 

• The number of distinct colors that can be represented by a piece of hardware or software. 

Color depth is sometimes referred to as bit depth because it is directly related to the 

number of bits used for each pixel. A 24-bit video adapter, for example, has a color depth 

of 2 to the 24th power (about 16.7 million) colors. One would say that its color depth is 

24 bits. 

• Also known as bit depth, is either the number of bits used to indicate the color of a single 

pixel, in a bitmapped image or video frame buffer, or the number of bits used for each 

color component of a single pixel. For consumer video standards, such as High 

Efficiency Video Coding (H.265), the bit depth specifies the number of bits used for each 

color component 

Comparison: same image on five different color depths (bits). Different looks 

(color/greyscale/black-and-white ... dithering), but also different file sizes. 

 
32bits.png;4,294,967,296 colors;98KB 
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8bits.png;256 colors;37KB(-62%) 

 
4bits.png;16 colors;13KB(-87%) 

IMAGE SIZE 

• The width and height of a bitmapped image, measured in pixels. 

• The size of a graphics file, measured in bytes. 

Image dimensions are the length and width of a digital image. It is usually measured in pixels, 

but some graphics programs allow you to view and work with your image in the equivalent 

inches or centimeters. Depending on what you plan to use your image for you may want to 

change the image size. For example, if you are using a high-resolution digital photograph, you 

may want to make the image dimensions smaller for publishing to a Web page. When using a 

graphics or image-editing program, you will usually have two options for changing the image 

dimensions: resize or resample. 
 

Multimedia Devices 

Types of Multimedia Devices 

List Types of Multimedia Devices 
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Multimedia devices such as webcams, digital cameras, MIDI ports, microphones, sound cards, 

and video capture cards are used by both home and business-oriented PCs. The following 

sections discuss the characteristics of each of these devices. 

Webcam 

A webcam is a simple digital camera capable of taking video or still images for transmission 

over the Internet. Unlike digital cameras (next section), webcams don't include storage 

capabilities. Most webcams plug into a USB port, but a few have used IEEE 1394 or parallel 

ports. Webcams are generally used in live chat situations, such as with AOL Instant Messenger 

or other IM clients. They offer resolutions ranging from sub-VGA to as high as 2 million pixels 

(2 megapixels). Some offer autofocus and zoom features for better image clarity, and some have 

built-in microphones. 

 
Digital Camera 

Digital cameras have largely replaced film cameras for both amateur and professional 

photography. They use CMOS or CCD image sensors to record images onto internal or card-

based flash memory form factors such as Compact Flash, SD, Memory Stick, xD-Picture Card, 

and Smart Media. Digital cameras transfer images to computers for emailing, printing, or 

storage via either flash memory card readers or direct USB port connections. 
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MIDI Music and MIDI Ports 

Musical instrument digital interface (MIDI) music is created from digitized samples of musical 

instruments that are stored in the ROM or RAM of a MIDI device (such as a sound card) and 

played under the command of a MIDI sequencer. MIDI sequences can be stored as files for 

future playback, and can be transferred between sound cards and MIDI-enabled devices such as 

keyboards via the MIDI port. 

Sound Card 

Sound cards are used to record and play back analog audio, and most can also play back digital 

audio sources as well. When recording analog audio sources such as CDs, line in or microphone 

in, sound cards digitize the audio at varying sample rates and store files in either uncompressed 

forms such as WAV or compressed forms such as WMA or MP3 

Most recent sound cards support 5.1 or 7.1 surround audio, and many sound cards also support 

digital stereo or surround audio playback standards via SPDIF ports. In recent years, sound cards 

have become less popular due to the popularity of onboard audio, but sound cards are preferred 

by users who create audio recordings. 
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Microphone 

Microphones plug into the 1/8-inch mini-jack microphone jack on a sound card or integrated 

motherboard audio. The most common microphones used on PCs include those built into 

headsets 
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Microphone volume is controlled by the Windows Sounds and Audio Devices applet's mixer 

control. Open the Recording tab to adjust volume, to mute or unmute the microphone, or to 

adjust microphone boost. 

The Minimum Requirement for Multimedia 

Outline Minimum Requirement for Multimedia 

1. MULTIMEDIA HARDWARE REQUIREMENTS 

• CPU Central Processing Unit (CPU) is an essential part in any computer. It is considered 

as the brain of computer, where processing and synchronization of all activities takes 

place. The efficiency of a computer is judged by the speed of the CPU in processing of 

data. For a multimedia computer a Pentium processor is preferred because of higher 

efficiency. 

• Monitor The monitor is used to see the computer output. Generally, it displays 25 rows 

and 80 columns of text. The text or graphics in a monitor is created as a result of an 

arrangement of tiny dots, called pixels. Resolution is the amount of details the monitor 

can render. Resolution is defined in terms of horizontal and vertical pixel (picture 

elements) displayed on the screen. 

• Video Grabbing Card We need to convert the analog video signal to digital signal for 

processing in a computer. Normal computer will not be able to do it alone. It requires 

special equipment called video grabbing card and software to this conversion process. 

This card translates the analog signal it receives from conventional sources such as a 

VCR or a video camera, and converts them into digital format. 

• Sound Card Today’s computers are capable of creating the professional multimedia 

needs. Not only you can use computer to compose your own music, but it can also be 

used for recognition of speech and synthesis. It can even read back the entire document 

for you. But before all this happens, we need to convert the conventional sound signal to 

computer understandable digital signals. This is done using a special component added to 

the system called sound card. 

• CD-Rom CD-ROM is a magnetic disk of 4.7 inches diameter and it can contain data up 

to 680 Megabytes. It has become a standard by itself basically for its massive storage 

capacity, faster data transfer rate. To access CD-ROM a very special d1rive is required 

and it is known as CD-ROM drive. 

2. MULTIMEDIA SOFTWARE REQUIREMENTS 

• Adobe CS4 Adobe CS4 is a collection of graphic design, video editing, and web 

development applications made by Adobe Systems many of which are the industry 

standard that includes 

• Adobe Dreamweaver Although a hybrid WYSIWYG and code-based web design and 

development application, Dreamweaver’s WYSIWYG mode can hide the HTML code 

details of pages from the user, making it possible for non-coders to create web pages and 

sites.WYSIWYG (What You See Is What You Get) web development software that 

allows users to create websites with out using Html, everything can be done visually. 

• Adobe Fireworks A graphics package that allows users to create bitmap and vector 

graphics editor with features such as: slices, the ability to add hotspots etc.) for rapidly 

creating website prototypes and application interfaces. 
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• Gimp Is an alternative to Photoshop and cheaper but not quite as good. 

• Google Sketchup SketchUp is a 3D modeling program designed for architects, civil 

engineers, filmmakers, game developers, and related professions. 

• Microsoft Frontpage As a WYSIWYG editor, FrontPage is designed to hide the details 

of pages’ HTML code from the user, making it possible for novices to easily create web 

pages and sites.  

• Apple Quicktime QuickTime is an extensible proprietary multimedia framework 

developed by Apple, capable of handling various formats of digital video, 3D models, 

sound, text, animation, music, panoramic images, and interactivity. 

• Photoshop Pro Adobe Photoshop, or simply Photoshop, is a graphics editing 

programdeveloped and published by Adobe Systems. It is the current market leader for 

commercial bitmap and image manipulation software, and is the flagship product of 

Adobe Systems. It has been described as “an industry standard for graphics 

professionals” 

• Microsoft Powerpoint Powerpoint Presentations are generally made up of slides may 

contain text, graphics, movies, and other objects, which may be arranged freely on the 

slide. 

• Adobe Flash Player Adobe Flash (formerly Macromedia Flash) is a multimedia platform 

that is popular for adding animation and interactivity to web pages. Originally acquired 

by Macromedia, Flash was introduced in 1996, and is currently developed and distributed 

by Adobe Systems.Flash is commonly used to create animation, advertisements, and 

various web page Flash components, to integrate video into web pages, and more 

recently, to develop rich Internet applications.  

• Adobe Shockwave Adobe Shockwave (formerly Macromedia Shockwave) is a 

multimedia player program, first developed by Macromedia, acquired by Adobe Systems 

in 2005. It allows Adobe Director applications to be published on the Internet and viewed 

in a web browser on any computer which has the Shockwave plug-in installed. 

Areas where Multimedia is Used 

Name areas where Multimedia is Used 

1. Advertising 

Advertising has changed a lot over the past couple of decades, and this is mainly due to the 

increased use of the internet in business. Multimedia plays a great and a vital role in the field of 

advertising. As whatever it is whether print or electronic advertisement, they first are prepared on 

the computer by using professionals' software's and then it is brought in front of the target 

audiences. 

• Print advertising 

• Radio (audio) advertising 

• Television (video) advertising 

• Digital advertising Display Ads Remarketing Video Social Search  

• Display Ads 

• Remarketing 

• Video 

• Social 

• Search 
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• Mobile advertising 

2. Education 

In the area of education too, the multimedia has a great importance. Talking particularly about 

the schools, their usage has a significant role to play for children also. It is broadly used in the 

field of education and training. We used audio for imparting education even in traditional 

method, where charts, models etc. were used. 

Nowadays the classroom need is not limited to that traditional method rather it needs audio and 

visual media. With the use of multimedia everything can be integrated into one system. As an 

education aid the PC contains a high-quality display with mic option. This all has promoted the 

development of a wide range of computer-based training. 

3. Mass Media 

It is used in the field of mass media i.e. journalism, in various magazines and newspapers that are 

published periodically. The use of multimedia plays a vital role in a publishing house as there are 

many works of newspaper designing and other stuff also. 

4. Gaming Industry 

• One of the most exciting applications of multimedia is games. Nowadays the live internet 

is used to play gaming with multiple players has become popular. In fact, the first 

application of multimedia system was in the field of entertainment and that too in the 

video game industry. The integrated audio and video effects make various types of games 

more entertaining. 

5. Science and Technology 

• Multimedia had a wide application in the field of science and technology. It is capable of 

transferring audio, sending message and formatted multimedia documents. At the same 

time the it also helps in live interaction through audio messages and it is only possible 

with the hypermedia. It reduces the time and cost can be arranged at any moment even in 

emergencies. 

 

 

Sound and Video 

The Concept of Sound and Audio 

Describe the Concept of Sound and Audio 

Audio Software 

Software to record and edit audio is often referred to as a digital audio editor. High-end systems 

for professionals are also called digital audio workstations. Audio can consist of only spoken 

text, such as the narration of this video, or include music and other sound effects. A digital audio 

editor typically contains functions for the following tasks: Record audio from a variety of 

different input sources Mix multiple tracks into one output track Apply effects, such as noise 

reduction and equalization, to improve the quality Edit sound clips by cutting out certain parts, 

switching the order of clips, etc. 

Sound 
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Sound is one of the most important element of Multimedia. It is meaningful “speech” in any 

language, from a whisper to a scream. It can provide the listening pleasure of music, the Startling 

accent of special effects or the ambience of a mood setting background. Sound is the terminology 

used in the analog form, and the digitized form of sound is called as audio. 

Animation 

Animation is the process of making the illusion of motion and the illusion of change by means of 

the rapid succession of sequential images that minimally differ from each other. The illusion as 

in motion pictures in general is thought to rely on the phi phenomenon and beta movement, but 

the exact causes are still unclear. There are some forms of animation that do not feature a rapid 

succession of sequential images, but these are usually not considered "true" or "full" animation. 

For instance, the physical movement of image parts through simple mechanics in magic lantern 

slides and the movement of the projector (the magic lantern) in phantasmagoria provided popular 

moving picture shows. 

Animators are artists who specialize in the creation of animation. Animation can be recorded 

with either analogue media, a flip book, motion picture film, video tape, digital media, including 

formats with animated GIF, Flash animation, and digital video. To display animation, a digital 

camera, computer, or projector are used along with new technologies that are produced. 

Elements of Audio 

Explain Elements of Audio 

There are four essential elements of audio 

• Element #1 - Nat Sound: Nat sound (also known as "natural sound" or "wild sound") 

includes any audio recorded along with the video that you shoot. This includes ambient 

audio. When you record a scene on a bench in a city park, the sound of children laughing 

and playing in the background is part of the nat sound in that environment. In the context 

of this article, we'll also consider on-camera dialogue that is recorded along with the 

visuals to be natural sound.Nat sound is often the only audio that amateur videographers 

include in their videos. While home videos typically consist entirely of this kind of audio, 

Hollywood producers go to great lengths to avoid using it altogether. The audio recorded 

with the images that are shot for most feature films is usually used only as a guideline by 

a team (or multiple teams) of people that re-creates every sound and every word of 

dialogue in a scene. Foley artists create and record everything from footsteps to keyboard 

clicks as separate sound elements that can be mixed together with great precision and 

control. While all of this may be unrealistic for the videos that you produce, there is an 

important principle to learn: if you want your videos to sound more like professional 

productions, you'll have to spend some time editing your audio.If you record dramas, 

documentaries, events, interviews or instructional videos, nat sound is the foundation of 

your soundtrack. It's critical that you start with the highest quality audio possible-this 

means that your camcorder's built-in microphone is not the best choice. An external 

microphone and a good pair of headphones are essential. 

• Element #2 - Music : Simply adding a track of background music can greatly improve 

your videos. Music has great power to impact your viewers emotionally, and the pros use 

it all the time to add zing to a scene. Listen carefully to the music tracks that accompany 

the programs that you watch on TV tonight. Music often creeps in quietly-unnoticed by 

the viewer-then builds as emotions heighten. Want to tell your audience how to feel? Use 

music. Some of the most suspenseful movies of all time are known by their music tracks 
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(Jaws and Psycho, for instance). The anticipation at the sound of the music in these 

movies could scare an audience out of its seat.In the same way that it can build tension 

and fear, music can build joy or excitement. Imagine how the music would swell (along 

with the hearts of the viewers) as a hero triumphantly emerged from a smoldering 

building with a child in his arms.You can change the entire feel of a scene by simply 

changing the music track. The same sequence of shots can feel spooky, silly or sad, 

depending on the music that you select. To see for yourself, shoot this short sequence, 

edit it together, then play it back with several different music tracks. 

• Element #3 - Sound Effects: These days, sound effects are more than just gunshots and 

explosions. As we said, most of the sounds you hear when you watch a feature film were 

created in a studio and edited into the production. You can use subtle sound effects to 

enhance your videos. Remember that interview in the park? Adding the sound of a rolling 

stream or some chirping birds can enhance the pleasant feeling of the setting.Look again 

at the three shot sequence where the reader hears a sound before leaving the room. Just 

what did he hear? A single CD of sound effects provides a variety of options to consider. 

Capture a few sounds, then edit them into your sequence. Did he hear a scream, a knock 

at the door, a police siren? Maybe it was a dog barking, the phone ringing or the sound of 

a marching band. Try a few of them, then revisit the music track. If you selected a 

dramatic sound like a gun or car crash, pick a suspenseful music track to coincide. You 

get the idea.Sound effect CDs are easy to find, and provide a number of options for just a 

few dollars. A sound effect CD is a good investment for a videographer, especially a CD 

that includes natural sounds. However, look closely at the contents of the disc before you 

buy. You may not have much use for a collection of carnival sounds. 

• Element #4 - Narration: If you produce documentaries, travel video, personal histories, 

instructional videos or any type of video that seeks to explain a procedure or tell a story, 

narration is invaluable. The best narration is well-scripted and planned to match the 

visuals in your production, not off-the-cuff rambling. If possible, it's a good idea to script 

out your narration before you shoot, then gather the shots that you need to match. If you 

cannot script the narration before you shoot, at least do it before you begin editing. It is 

much easier to lay the narration on the timeline and edit your footage to the words than it 

is to write a tight narration that matches your edited video. 

Stage of Make Sound for Multimedia 
 

Video Recording / Shooting 

The Concept of Video Recording 

Explain the Concept of Video Recording 

Video recording is a recording of both the visual and audible components (especially one 

containing a recording of a movie or television program) 

Multimedia production provides high-definition (HD) video recording and editing services for 

both academic instruction and research projects. Services include: 

• The creation of professional quality video productions for instruction and demonstration; 

• Live event webcasting; and 

• Live-linking with major broadcast networks 
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• Consulting services on the uploading and delivery of recorded digital content for 

streaming and to university servers and websites; and 

• Consulting support on the creation of accessible digital media, such as transcribing and 

captioning, in accordance with current legislation. 

How to Extract Frames from Video with High Quality 

Sometimes we tend to capture a lot of video footage and while it can be fun at first, going 

through it can be quite the hassle. There are situations when you just need that perfect frame, a 

great shot that will help you bring in front a lot of fun. Basically, with a frame you can show the 

fun moments of any video, you can bring in front a specific important moments from that scene 

or you can even reproduce some of the movie scenes via an image collage 

Not only that, but you can also use the frames in order to create a GIF file, something that is very 

important and helpful as you go along. It’s all about having the ability to use these frames as you 

see fit, and they can either be a DVD cover, a collage for your birthday and so on. The 

possibilities are indeed endless and it all comes down to you to choose them properly. 

• In this sub topic you will learn how you can extract frames from video and also figure out 

how you can save them in a specific format. You will have the ability to harness the 

power of video editing and access the tools that you always needed all so that you can 

extract frames immediately and with great results. 

HOW TO EXTRACT FRAMES FROM VIDEO WITH WONDERSHARE FILMORA 

Import your video clip 

Import the media file first either by using the app or via drag and drop on the main window. 

Videos will show as thumbnails in the library so you can choose the one you need without a 

problem. Next drag them to the Video Timeline 

 
2.Extract frames from video 
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Start playing the desired video and then pause it when it reaches the right moment. Right click it 

and select "Flash and Hold". Immediately, there will be a picture icon added to the whole clip. 

Play it to check the real-time effect. 

 
If you want to get the same resolution frame as the original, click the video in the Media Library 

and then click the Play button in the Preview Window. Take a screenshot when the video is 

playing simply by pressing the Snapshot icon or via pressing CTRL+ALT+S. 

 
Once you have the frame you can add in a variety of effects and features. You can choose to 

mask it, add in specific effects and also deliver some motion to make it more appealing. There 

are many customization options to choose from and it all comes down to you. 



37 
 

3.Save your frames 

After you are satisfied with the results you will be able to export your content. Click Export to 

start the export process, then choose the desired output format. You can easily customize the 

output file resolution and other settings depending on the format you choose. 

 
In conclusion, using WonderShare Filmora to extract frames from video is not only very simple, 

it also offers an amazing set of opportunities. We recommend you to try out the app immediately 

and you will surely have no problem extracting the desired frames. 

The Steps to Capture a Single Frame 

Outline the Steps to Capture a Single Frame 

The Steps to Capture a Multiple Frame 
 

 

Video Editing 

The concept of video editing 

Explain the concept of video editing  

Video editing is the manipulation and arrangement of video shots. Video editing is used to 

structure and present all video information, including films and television shows, video 

advertisements and video essays. Video editing has been dramatically democratized in recent 

years by editing software available for personal computers. 

Video editing is the process of manipulating video by rearranging different shots and scenes in 

order to create a whole new output. It can be as simple as stitching together different scenes and 

shots with simple video transitions, and can become as complicated as adding different 

computer-generated imagery (CGI), audio and tying together different elements, which may take 
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years, thousands of man-hours and millions of dollars to accomplish, as is the case with big-

budget motion pictures. 

Tasks in video editing include: 

• Removing unwanted footage or editing out some scene elements 

• Choosing the best shots and footage to go into the final output 

• Creating the flow of the narrative by arranging and rearranging scenes 

• Adding effects, filters and additional elements such as CGI 

Video editing software 

Use video editing software 

Video editing software is an application program which handles the post-production video 

editing of digital video sequences on a computer non-linear editing system (NLE). It has 

replaced traditional flatbed celluloid film editing tools and analogue video tape-to-tape online 

editing machines. 

How to use video editing software? 

• The best video editor for beginners is Wondershare Filmora. Let see some use: 

Select Clips in the Media Library 

• Select one media file: click a thumbnail. 

• Select multiple media files: press and hold [Ctrl], and then click the thumbnails you want. 

• Select a sequence of media files: click the first thumbnail in the sequence, press and hold 

[Shift], and then click the last thumbnail in the sequence. 

• Note: You can locate the media file directly by searching its name in the Search bar 

 
Delete Media Clips from the Media Library 

• In the Library, right click the clip and select DELETE. 
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• Note: When you delete a clip from the library, only the reference is deleted not the actual 

clip. All the clips still remain in their original location since they are just referenced in 

the Media Library. You can still find the file in the location where it is stored. 

Add Clips to a Video/PIP Sequence in the Timeline 

• Do one of the following to add clips to the Timeline panel in Filmora:Drag and drop the 

thumbnail of the media file in the media library panel to the Timeline. 

 

• Choose target, right click to ADD CLIP or APPLY TO PIP. 

• Tips: Automatically the file will be dropped at the very beginning of the video track. 

When you drag and drop the next one that will be sticking to the previous file 

automatically. It is designed to prevent the black frames from generating after exporting 

the video. 

• What's more, for better arranging your clips, Wondershare Filmora allows you to add up 

to 10 PIP tracks. 

Access Sample Colors or Sample Intro Video 

• Filmora also provides several sample colors or intro video. To get access these resources, 

just click "User's Album" and choose SAMPLE COLORS or SAMPLE VIDEO. 



40 
 

 
Delete Clips from Timeline 

Do one of the following: 

• Right click a clip and select DELETE 

• Select a clip and hit the DELETE buttonin the menu section or the Delete button on the 

keyboard 

 

Video Compression 

The Video Compression 

Describe Video Compression 

Video compression is the process of encoding a video file in such a way that it consumes less 

space than the original file and is easier to transmit over the network/Internet. It is a type of 

compression technique that reduces the size of video file formats by eliminating redundant and 

non-functional data from the original video file. 

Video compression is performed through a video codec that works on one or more compression 

algorithms. Usually video compression is done by removing repetitive images, sounds and/or 

scenes from a video. For example, a video may have the same background, image or sound 

played several times or the data displayed/attached with video file is not that important. Video 

compression will remove all such data to reduce the video file size. 

Videos take up a lot of space just how much varies widely depending on the video format, the 

resolution and the number of frames per second you select. Uncompressed 1080 HD video 

footage takes up about 10.5 GB of space per minute of video. If you use a smartphone to shoot 

your video, 1080p footage takes up 130 MB per minute of footage, while 4K video takes up 375 

MB of space for each minute film. Because it takes up so much space, the video must be 

compressed before it is put on the web. 

“Compressed” just means that the information is packed into a smaller space. There are two 

kinds of compression:  
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1. lossy  

2. Lossless. 

1. Lossy Compression 

• Lossy compression means that the compressed file has fewer data in it than the original 

file. In some cases, this translates to lower quality files, because information has been 

“lost,” hence the name. However, you can lose a relatively large amount of data before 

you start to notice a difference. Lossy compression makes up for the loss in quality by 

producing comparatively small files. For example, DVDs are compressed using the 

MPEG-2 format, which can make files 15 to 30 times smaller, but viewers still tend to 

perceive DVDs as having high-quality pictures.Most video that is uploaded to the internet 

uses lossy compression to keep the file size small while delivering a relatively high-

quality product. 

2.Lossless Compression 

• Lossless compression is exactly what it sounds like, compression where none of the 

information is lost. This is not nearly as useful as lossy compression because files often 

end up being the same size as they were before compression. This may seem pointless, as 

reducing the file size is the primary goal of compression. However, if the file size is not 

an issue, using lossless compression results in a perfect-quality picture.For example, a 

video editor transferring files from one computer to another using a hard drive might 

choose to use lossless compression to preserve quality while he is working. 
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